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X-RITE SOFTWARE LICENSE AGREEMENT 

 

IMPORTANT – THIS IS A LEGAL AGREEMENT BETWEEN YOU AND X-RITE, INCORPORATED. 

 

BY LOADING OR USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ THIS 

LICENSE AGREEMENT, THAT YOU UNDERSTAND IT, AND THAT YOU AGREE TO BE BOUND BY 

ITS TERMS.  IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS LICENSE 

AGREEMENT, THEN X-RITE IS UNWILLING TO GRANT YOU A LICENSE TO USE THE SOFTWARE, 

AND YOU MAY NOT USE THE SOFTWARE.   PROMPTLY UNINSTALL THE SOFTWARE FROM ANY 

AND ALL COMPUTERS AND, IF YOU PURCHASED THIS SOFTWARE PRODUCT, PROMPTLY 

RETURN THE SOFTWARE AND THE ACCOMPANYING ITEMS (INCLUDING WRITTEN MATERIALS 

AND BINDERS OR OTHER CONTAINERS) TO THE PLACE YOU OBTAINED THEM FOR A REFUND. 

 

DEFINITIONS 
In this Agreement, the term "Software" means X-Rite Software provided to you, including associated user 

documentation, in electronic, digital, or printed form.  The term "You" or "you" means the company, entity or 

individual who is acquiring the license to use the Software under this Agreement. 

 

SOFTWARE LICENSE 

 

Grant.  Subject to the terms and condition of this Agreement, X-Rite hereby grants to You a limited, nonexclusive 

license to use the Software, in object code format only, solely in connection with Your own business operations and on 

the terms and conditions set forth in this Agreement.  You may use the Software only with number of concurrent users 

(user sessions that may be logged into the Software at any one time) specified by X-Rite. 

 

Copies.  You may make one copy of the Software and documentation for nonproductive, back-up, archival and testing 

purposes provided that X-Rite’s copyright and other proprietary legends are reproduced on each copy.  The copy made 

by You shall be the property of X-Rite.  You may not copy the written materials accompanying the Software, and you 

may not remove the labels or proprietary legends from the Software or its documentation. 

 

Restrictions.  In addition to other restrictions set forth in this Agreement, You may not (a) use, copy, modify or 

distribute the Software (electronically or otherwise) or any copy, adaptation, transcription or merged portion thereof 

except as expressly authorized under this Agreement; (b) use the Software for the benefit of third parties in a 

commercial, retail, service bureau or similar enterprise, except as permitted under this Agreement; (c) reverse 

assemble, reverse compile or decompile the Software or otherwise examine the Software for purposes of reverse 

engineering; or (d) distribute any serial number supplied to you by X-Rite, except as a permanent transfer of single 

copy of the Software in its registered, fully functional mode to one new owner, as provided in this Agreement. 

 

Copies – Demo Software.  If the Software is a demonstration version of X-Rite software (“Demo Software”), then you 

may copy and distribute verbatim copies of the Demo Software as you receive it, solely for purposes of demonstration 

and evaluation, provided that you (i) conspicuously and appropriately publish on each copy an appropriate copyright 

notice and disclaimer of warranty; (ii) keep intact all the notices that refer to this Agreement and to the absence of any 

warranty; (iii) distribute the Demo Software's installer complete with all of its support and documentation files; and (iv) 

give any recipient of the Demo Software a copy of this Agreement. 

 

Conversion of Demo Software.  If the Software is Demo Software, then You may, by contacting X-Rite and paying a 

licensing fee, obtain a serial number and authorization to convert the Demo Software to a registered, fully functional 

version.  Conversion of Demo Software by any other means violates the terms of this Agreement. Additional licenses to 

use the Software by additional concurrent users in its registered, fully functional mode may also be obtained from X-

Rite. 

 

Title.  X-Rite reserves all rights not expressly granted to You hereunder.  You understand that the license granted 

herein transfers neither title nor proprietary rights to You with respect to the Software.   
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Audit.  X-Rite shall have the right, at any time, to audit Your use of the Software to monitor compliance with this 

Agreement.  If the audit is conducted on Your premises, X-Rite shall give You at least ten (10) days’ prior written 

notice and such audit shall be conducted during Your normal business hours. 

 

Disabling Devices.  YOU ACKNOWLEDGE THAT THE SOFTWARE MAY CONTAIN SOFTWARE 

PROCEDURES OR OTHER MECHANISMS THAT ENFORCE USE RESTRICTIONS AND THAT MAY 

DISABLE FUNCTIONALITY OF THE SOFTWARE AND PREVENT ACCESS TO DATA USING THE 

SOFTWARE AT THE END OF ANY EVALUATION PERIOD, IF APPLICABLE, OR UPON VIOLATION OF 

THE TERMS OF THIS AGREEMENT. 

 

UPGRADES 

If the Software is an upgrade of an X-Rite product, then You now may use that upgraded product only in accordance 

with this Agreement.  If the Software is an upgrade of a component of a package of Software programs that You 

licensed as a single product, then the Software may be used and transferred only as part of that single product package 

and may not be separated for use on more than one computer. You may not loan, rent, lease, or otherwise transfer the 

original non-upgraded product to another user, except as part of the permanent transfer (as provided above in 

"Transfer") of the Software. 

 

PROFILE USE 

Defined.  For purposes of this Agreement, the term "Profile" means the data stored in look-up tables for characterizing 

various input, display, and output devices.  Profiles are used for providing transformations between well-defined color 

metrics and for device characterization and calibration.   

 

General.  If the Software creates Profiles, then the license to use the Software shall include a nonexclusive license to 

use the Profiles, subject to the additional restrictions below. 

 

Restrictions.   

 

 (a)  You may use each Profile only for the specific display, input or output device owned by you, for which 

the device Profile was created;  

 

 (b)  A Profile may be shared with third parties for proofing purposes, provided that the Profile (i) is 

embedded within an image or publication; or (ii) sent to a service provider along with an image or publication for use 

exclusively with that image or publication;  

 

 (c)  A Profile may be used by a third party only on a specific display, input or output device owned by the 

third party for which the device Profile was created as part of Your commercial profiling service to such third party. 

 

 (d)  Except as expressly permitted in this Agreement, You may not Yourself or through any other person, do 

any of the following: (i) sell, license, sublicense, lease, rent, lend, disclose, permit access to, or transfer to any third 

party, whether for profit or without charge, any Profile; (ii) allow any third party to use a Profile; or (iii) distribute to 

any third party a Profile in any way or form, whether by networks, electronic bulletin boards, web sites or otherwise.   

X-Rite may permit certain distribution rights under a separate written distribution agreement. 

 

MULTIPLE ENVIRONMENT SOFTWARE 

If the Software contains, or, in connection with the acquisition of the Software contained in this package You receive, 

two or more operating environment versions of the Software (e.g., Macintosh® and Windows®) two or more language 

translation versions of the Software, the same Software on two or more media (e.g., diskettes and a CD-ROM), and/or 

You otherwise receive two or more copies of the Software, then the total number of concurrent users of all versions of 

the Software may not exceed the number of concurrent users allowed under the license.  You may not rent, lease, 

sublicense, lend or transfer versions or copies of the Software You do not use, or Software contained on any unused 

media, except as part of the permanent transfer of all Software and documentation, further described below. 

 

LIMITED WARRANTY 

Provided that you received the Software from X-Rite directly, X-Rite warrants, for Your benefit alone, that the 

Software (excluding Demo Software) will operate in substantial conformance with its then-current documentation for a 

period of ninety (90) days after receipt.  X-Rite’s sole obligation to You, and Your exclusive remedy for breach of this 

warranty, is to correct or replace, at no charge, any nonconformity of which it receives notice during the warranty 

period and which Software is returned to X-Rite with a copy of Your receipt.  This limited warranty is expressly 

conditioned on Your compliance with the operating procedures set forth in the Software documentation.  X-Rite shall 

not be obligated to correct, cure, or otherwise remedy any nonconformity or defect in the Software if You have made 
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any changes to, misused, or damaged the Software. Outside the United States, these remedies are not available without 

proof of purchase from an authorized non-U.S. source.   

 

ALL DEMO SOFTWARE IS PROVIDED TO YOU “AS-IS,” WITHOUT ANY WARRANTIES. 

 

DISCLAIMER  

EXCEPT FOR THE LIMITED WARRANTY ABOVE, X-RITE DISCLAIMS ALL WARRANTIES, EITHER 

EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT 

WITH REGARD TO THE SOFTWARE, THE ASSOCITED DOCUMENTATION, AND ANY ACCOMPANYING 

HARDWARE.  

 

NO LIABILITY FOR CONSEQUENTIAL DAMAGES 

IN NO EVENT SHALL X-RITE OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES WHATSOEVER 

(INCLUDING, WITHOUT LIMITATION, SPECIAL, INCIDENTAL, INDIRECT AND CONSEQUENTIAL 

DAMAGES FOR LOSS OF BUSINESS PROFIT, BUSINESS INTERRUPTION, LOSS OF BUSINESS 

INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO 

USE THE SOFTWARE, EVEN IF X-RITE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  

IN ANY CASE, X-RITE’S ENTIRE LIABILITY UNDER ANY PROVISION OF THIS AGREEMENT SHALL BE 

LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU FOR THE SOFTWARE.  BECAUSE SOME 

STATES/COUNTRIES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR 

CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU. 

 

TRANSFER/LIMITATIONS 

This Agreement is your proof of license to exercise the rights granted herein and must be retained by You.  You may 

transfer the Software and accompanying written materials on a permanent basis, provided that You retain no copies and 

the recipient agrees to the terms of this License Agreement.  If the Software is an update or has been updated, any 

transfer must include the most recent update and all prior versions.  Warranty and other service entitlements are not 

transferable.  The recipient has no rights to demand these actions of X-Rite or X-Rite’s designated service facilities. 

 

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection 

in exchange for a fee, but only with express prior written permission of X-Rite. You may not impose any further 

restrictions on the recipients' exercise of the rights granted herein. 

 

U.S. GOVERNMENT RESTRICTED RIGHTS. 

The Software and documentation are provided with RESTRICTED RIGHTS.  Use, duplication, or disclosure by the 

Government is subject to restrictions as set forth in subparagraph (c)(1) and (ii) of the Rights in Technical Data and 

Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer 

Software – Restricted Rights at 48 CFR 52.227-19, as applicable. 

 

If you acquired this product in the United States, then this Agreement is governed by the laws of the State of Michigan. 

Should you have any questions concerning this Agreement, please contact:  

X-Rite, Incorporated - 4300 44th Street, S.E. – Grand Rapids, MI  49512 - Phone (616) 803-2100 - Fax (616) 803-2513 
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Introduction 
 

ColorPort is intended for graphic arts professionals who require a calibrated color-

managed environment. This guide will help you make good use of ColorPort to enhance 

your work. 

 

 

 

Overview 
 

ColorPort is a robust application that, through a simple and intuitive interface, lets you 

create, save, and measure targets, and extract the resultant data. 

 

This is extremely useful in situations where a particular instrument is not supported by a 

color profiling software application. In this scenario, ColorPort creates, measures, and 

exports target data using the instrument. The profiling application imports the exported 

target data where it can subsequently be used to create the desired profile. 

 

ColorPort's rich feature set includes: 

 

! Support for industry standard targets 

! Support for all MonacoPROFILER linearization and profile generation targets 

! Support for all MonacoPROFILER target building options 

! Added support for Eye-One iO and Eye-One iSis devices, and ProfileMaker 

! Support for user-defined or custom target generation 

! Customize targets for device specific layouts 

! Standard and custom paper sizes for target generation 

! Onscreen preview of the target, utilizing all target generation parameters 

! Portrait/Landscape option for target generation 

! Save RGB & CMYK targets in TIFF format 

! Save 5-8 color targets as TIFF or DCS 2.0 

! Target measurement with industry-standard instruments 

! Save/export measurement data in both CGATS and user-defined text formats 

! Direct data export to MonacoPROFILER 

! Export data for use in ProfileMaker 

 

 

About this manual 
 

This guide assumes you have a good understanding of your computer and operating 

system, and have a working knowledge of a supported measurement device. It also 

assumes you are familiar with color management.  

 

This manual provides instructions on the basic functions of ColorPort in real-world 
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settings. You will learn how to quickly and effectively build, measure, save and manage 

target data. You can also learn advanced concepts such as: 

 

! Customizing targets and device options 

! Sharing targets with other X-Rite applications 

! Configuring and using supported measurement devices 

 

If you require more information about ColorPort or any of X-Rite's products and services, 

please visit our website at http://www.xrite.com. Our website features extensive customer 

support information and valuable resources such as: 

 

! User downloads 

! Online tutorials  

 

You may also contact one of our helpful customer service representatives at 800-248-

9748. 

 

 

 

Using help within the application 
 

If you require assistance within the application, click the Help button to access the online 

version of this document or to download a printable version. 
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Minimum system requirements 
 

MacintoshPower PC® Processor  

Mac OS X version 10.3.9 or higher  

 

Windows Pentium® PC or faster processor  

Microsoft® Windows 2000/XP/Vista.  

 

256 MB of available RAM  

120 MB of available hard-disk space  

 

 

 

Supported measurement devices 

 

Measuring a target with ColorPort requires a supported measurement device. ColorPort 

supports the following measurement devices:  

 

X-Rite DTP20 (PULSE)  

X-Rite DTP41/DTP41T  

X-Rite DTP45  

X-Rite DTP70  

X-Rite DTP22  

X-Rite 530  

X-Rite SP62, SP64  

X-Rite 938, 939, 962, 964  

X-Rite SpectroScan  

X-Rite Eye-One, Eye-One iO, Eye-One iSis 

X-Rite ICColor 

ColorPartner ColorScout A 
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About ColorPort targets 
 

ColorPort generates TIFF and DCS 2.0 type targets that can be printed from an 

application of your choice. Immediately after you save a target, you can measure it within 

ColorPort. The resulting data can then be exported easily for use with other applications. 

 

ColorPort creates: 

 

Custom targets for profiling and other graphic arts workflows 

Industry standard targets for evaluation of measurement equipment 

Profiling and linearization targets for use in MonacoPROFILER 

 

 

 

About X-Rite, Inc. 
 

X-Rite helps companies grow more profitable by providing hardware, software and 

support solutions that ensure color accuracy and data communication when color output 

is critical to business. Our worldwide customer base crosses a variety of markets such as:  

 

Graphic Arts 

Printing 

Packaging 

Digital and On-Demand Printing 

Manufacturing 

Retail Color Matching.  

 

X-Rite's history of innovation has provided a variety of products that measure and track 

color data, helping customers achieve more efficient and profitable solutions for 

managing their businesses and markets. In July, 2006 a new X-Rite organization formed 

through the acquisition of Amazys Holding AG / GretagMacbeth, that unites the best of 

both companies' innovation, technology, products and talent. Follow our performance on 

the NASDAQ exchange, symbol: XRIT. 

 

For more information about X-Rite and our other products and services, please visit our 

website at http://www.xrite.com or contact one of our customer service representatives at 

800-248-9748. 
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Basic operation 
 

 

 

 

Creating a target 
 

You can generate a target for a supported measurement device using either a predefined 

patch set or a new patch set that you create from scratch. For a list of predefined patch 

sets, see Supported patch sets by color space. For a list of supported devices see 

Supported measurement devices. 

 

For more options for target creation, please refer to Customizing targets. 

 

To create a target using a predefined patch set: 

 

1. Launch ColorPort and select the Create Target tab if it is not already active. 

 

The Create Target tab displays the settings last used to create a target and a 

preview of that target. As the settings are changed to create the new target, the 

Target Preview image updates in real-time to reflect the changes.  

 

2. Select a measurement device from the Measurement Device list. Configure any 

changes to the default device settings by clicking the Properties button. 

 

! NOTE: the Properties button will not be available if the Default Layout 

checkbox is selected. 

! The default settings in the device Properties window are based on the 

standard aperture size of the selected device.  

! Click the Properties button to change the settings, if needed, to meet the 

requirements of your aperture size. For more information, see Advanced 

Options: Customizing Device Options. 

 

3. Select a color space for your target from the Color Space list and configure the 

Channels option, if applicable.  

 

4. Select a patch set from the Patch Set list. The list includes patch sets containing 

the same number of colorants as the selected color space. If you change your 

color space selection, the patch set display will also change. 

 

! If you are creating a target for use by MonacoPROFILER, select a patch 

setting beginning with "X-Rite Profile".  

! If you are creating a target based on an Industry Standard patch set, select 

an ECI or IT8 patch set.  

! If you are creating a patch set from scratch, select New and refer to 
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Advanced Options:  Creating a new patch set . 

 

5. Check the Profiler Layout checkbox if you wish to select and lock all standard 

defaults for an X-Rite Profiler target. 

 

! This option pre-selects and locks all device settings, page orientation and 

margins, and prevents them from being further edited. 

! Note that the Customize button is still available. You may still configure the 

Scrambling, Target Ink Limiting and Linearization options in the Customize 

window. 

! The Page Size option is still enabled as Profiler allows multiple page sizes, 

but not changes in margin settings. 

 

6. Patch sets have certain parameters that can be customized. To modify the patch 

set's default settings, click Customize. 

 

! If you are customizing a Profiler patch set, refer to Advanced Options: 

Customizing a Profiler compatible patch set. 

! If you are customizing an industry standard patch set, refer to Advanced 

Options:  Customizing an Industry Standard patch set . 

 

7. Specify the layout for the paper you will use to print the target.  

 

! To print to a custom paper size, select New from the Paper Size list and 

enter the dimensions. 

! Select the orientation of your paper (Portrait or Landscape) from the drop-

down list.  

! Click the Margins button (below the Paper Size list), and adjust the margin 

widths to your requirements. 

 

8. Click Save Target... and save the target as a TIFF file(s) or DCS2.0 file. For more 

information, see Saving a Target. 

 

 

 
Saving a target 
 

ColorPort can save new targets that have been created in the Create Target tab. Saving 

target files also generates the necessary internal CGATS reference files that ColorPort 

uses for measuring targets in the Measure Target tab. The target image files can be saved 

in either a TIFF or DCS 2.0 (for 5 color or more) file type. 

 

Immediately after being saved, a new target is available in the Target drop-down list in 

the Measure Target tab. 
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To save a new target: 

 

1. Create a new target as described in Creating a Target. 

 

2. Click the Save Target… button or select File > Save Target… 

 

! This action will open a standard Save dialog box. Navigate to the directory 

in which you wish to store the target image file, and rename the target if 

desired. 

! Note that if the target is for a 5 color or more color space, you will have the 

option to save the file in a DCS 2.0 file format. This option is available from 

the format drop-down list. 

 

3. Confirm the desired file format and click Save. 

 

! The saved image area is defined by the red outline in the Target Preview 

image. 

! ColorPort automatically generates the associated CGATS reference file for 

use in the Measure Target tab. 

! If the target set includes multiple pages, the name shown in the Save dialog 

box is the base name for the group of saved files. Page numbers are 

appended to the base file name. For example, the file name "1 Profiler 343 

Patch Target .tif" indicates the file is page 1 in a set. A target entitled 

"Profiler 343 Patch Target.tif" indicates it is a single-page target file.  

 

 

Measuring a target 
 

You can measure a printed target with a supported measurement device. ColorPort does 

not print targets-you must print the target file with another application of your choice. For 

more information about printing targets, see Printing a target. 

 

You may create source targets following the steps outlined in Creating a Target or use a 

predefined target (i.e., a FOGRA media wedge or industry standard target), for which you 

have the corresponding reference file. 

 

To measure a target: 

 

1. Launch ColorPort and select the Measure Target tab if it is not already active. 

 

! The Measure Target tab displays the settings last used to measure and 

preview a target. As you change the settings and prepare to measure a new 

target, the Target Preview image updates in real-time to reflect the changes.  

 

2. Select the desired target from the Target drop-down list. The selected target's 
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parameters (Creation Date, Target Type, Patches, Page Count) will display below 

the drop-down list. This information should be consistent with the information 

slugline on your printed target. 

 

3. Select your measurement device from the Measurement Device list and the 

appropriate Serial port, if applicable. Click Connect. 

 

4. Measure a printed, dried and trimmed target with your connected device. 

 

! View the status of the measurements in the Measurement Status pane. The 

number of measured patches will be displayed against the total number of 

patches in the target (i.e. - 300/1485). You may also monitor your progress 

in the Progress Bar. 

! Click the Info button to view information about a selected patch in the 

Target Preview pane. Select the desired display format for the Measurement 

Info by clicking the appropriate radio button (Colorimetic, Spectral, 

Density). 

! Check the Show missing measurements checkbox to outline in green in the 

Target Preview pane any patches that were not measured. 

! Click the Clear Data… button to clear all measurement data and restore the 

measurement session to its starting point. This button is only active when 

there are measurements available to clear. 

 

5. Click the Save Data… button to save the measurement data. Measurement data 

can be saved in a format of your choice: 

 

! CGATS formatted file 

! Text file - Tab Delimited or Comma Separated Values (CSV). 

 

For more information about saving target data, see Target Data Formats. 

 

 

 

Managing targets 
 

ColorPort has a Target Manager that allows you to manage the target reference files you 

have created. Use the Target Manager to delete unwanted items, import target reference 

files created on a separate system, and export reference files for sharing with other 

ColorPort users. 

 

Note: A target must first be saved for it to appear in the Target Manager.  

 

To manage ColorPort target reference files: 

 

1. Select File > Target Manager… or the Target Manager… option from the Target 
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drop-down list in the Measure Target tab. 

 

2. To import a target into ColorPort, click the Import button. 

 

This will open a standard Open dialog box. Navigate to the directory where 

your reference file is stored and open it. This will import the file into 

ColorPort and it will be available immediately for use. NOTE: Fogra Media 

Wedge target references can be found in a folder called "FograReferences", 

which was installed on your computer in the same directory where you 

installed ColorPort. 

 

3. To export a ColorPort target reference file, select the desired file in the file list 

pane, and click the Export button. 

 

This will open a standard Save As… dialog box. Navigate to the directory 

where you wish to store the file, rename it if desired, and click Save. The file 

will now be exported as an XML file type that can be shared with other 

ColorPort users. 

 

4. To delete an unwanted target reference file, select it from the file list pane and 

click Delete. You will be presented with a confirmation dialog box. Click OK to 

complete the deletion. 
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Advanced options 
 

 

 

 

Customizing targets 
 

The Customize option lets you modify a pre-defined patch set or create a new patch set 

by importing compatible data.  

 

Predefined patch sets are divided into three categories: X-Rite Profile, industry 

standard, and X-Rite linearization.  

 

! X-Rite Profile patch sets contain the label "X-Rite Profile" and are compatible 

with MonacoPROFILER. This category includes the multicolor (5, 6, 7, or 8 

color) patch sets. MonacoPROFILER patch sets can be customized by 

enabling/disabling the scrambling, linearization, and target ink limit options. The 

color values of individual patches cannot be modified.  

! Industry standard patch sets include all supported ECI and IT8 targets, as well 

as three ProfileMaker targets. These targets can be customized by adding, 

deleting, and reordering patches, or by tweaking the color values of individual 

patches.   

! X-Rite Linearization patch sets are used to generate linearization data for use 

with MonacoPROFILER targets. These patch sets cannot be customized.  

 

 

Creating a new patch set 
 

You can use ColorPort to create a new patch set by importing patch data in a supported 

format (CGATS.5, CGATS.17, TAB or CSV). Use the new patch set to create a custom 

target in the Create Target tab. 

 

To create a new patch set by importing data: 

 

1. Launch ColorPort and select the Create Target tab if it is not already active. 

 

2. Select a measurement device from the Measurement Device list. Configure any 

changes to the default device settings by clicking the Properties button. NOTE: 

the Properties button will not be available if the Default Layout checkbox is 

selected. 

 

3. Select a color space for your patch set from the Color Space drop-down list and 

configure the Channels option, if applicable.  
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4. Select New from the Patch Set drop-down list. 

 

5. When the Customize window opens, enter a name for the new patch set in the 

Target Name field. 

 

6. If you are creating a patch set from scratch, proceed to the next step and add 

patches manually. If you are creating a patch set by importing patch data, click 

Import Patches to locate and import a stored patch data file. 

 

7. Add, delete, tweak, or reorder patches as desired.  

 

Click the (+) button and enter values manually to add a patch.  

Highlight a row and click the (-) button to delete a patch.  

Highlight an individual patch value and enter new values to tweak a patch.  

Highlight a row and drag it to a new position to reorder patches.  

 

8. When the patch set is configured as desired, click Save. The customized patch set 

appears as the active selection in the Patch Set list.  

 

9. Configure the Paper Size options as desired. 

 

10. Click the Save Target… button to rename and save the target file to a directory of 

your choice. 

 

 

Customizing a MonacoPROFILER-compatible patch set 
 

To customize a MonacoPROFILER compatible patch set:  

 

1. Launch ColorPort and select the Create Target tab if it is not already active.  

 

2. Select a measurement device from the Measurement Device list. Configure any 

changes to the default device settings by clicking the Properties button. NOTE: 

the Properties button will not be available if the Default Layout checkbox is 

selected. 

 

3. Select a color space for your target from the Color Space drop-down list and 

configure the Channels option, if applicable.  

 

4. Select a Profiler compatible patch set from the Patch Set list. For a complete list 

of compatible targets, see Supported Patch Sets by Color Space. 

 

5. Click the Customize button.  

 

! Choosing the Scramble Patches option reorders the sequence of patches in 
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a target. This is useful when printing from a device that outputs ink non-

uniformly (presses). By default, the Scramble Patches setting is enabled. 

Uncheck this option, if desired. 

! To ink-limit the target, check the Target Ink Limiting checkbox, and set 

the ink limit slider to the desired setting. Ink coverage varies according to 

printer, ink, and media used--if the ink coverage is too heavy on the 

printed target, adjust the amount of ink used by selecting a different Target 

Ink Limit setting, and reprint the patch set. This ensures that the output 

device will not deliver more ink than the media can absorb. Note that 

adjusting the Target Ink Limit setting causes a recalculation of the number 

of patches in the patch set. 

! To use linearization data during target creation, check the Linearization 

checkbox and select a linearization file from the drop-down list. For more 

information, see Customizing targets using linearization.  

 

6. Click Save. The customized patch set appears as the active selection in the Patch 

Set drop-down list.  

 

7. Configure the Paper Size options as desired. 

 

      8.   Click the Save Target… button to rename and save the target file to a directory of 

your choice.  

 

 

Customizing an industry standard patch set 
 

For the purposes of this example, industry standard patch sets are defined as ECI 2002 

Random, ECI 2002 Visual, IT8.7/3 Basic, IT8.7/3 Extended, IT8.7/4 Random, and 

IT8.7/4 Visual. All of these patch sets use a CMYK color space. For more information, 

see  Standard Target Information . 

 

To customize an industry standard patch set:  

 

1. Launch ColorPort and select the Create Target tab if it is not already active.  

 

2. Select a measurement device from the Measurement Device list. Configure any 

changes to the default device settings by clicking the Properties button. 

 

3. Select CMYK from the Color Space drop-down list.  

 

4. Select one of the above mentioned patch sets from the Patch Set list.  

 

5. Click the Customize button.  

 

6. Enter a new name for the customized patch set in the Target Name field. 
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7. Add, import, delete, tweak, or reorder patches as desired.  

 

Click the (+) button and enter values manually to add a patch.  

Click Import Patches, to locate and import a stored patch data file.  

Highlight a row and click the (-) button to delete a patch. 

Highlight a row and drag it to a new position to reorder patches.  

Highlight an individual patch value and enter new values to tweak a patch. 

 

8. When the patch set is configured as desired, click Save. The customized patch set 

appears as the active selection in the Patch Set list. 

 

1. Configure the Paper Size options as desired. 

 

2. Click the Save Target… button to rename and save the target file to a directory of 

your choice.  

 

 

 

Customizing targets using linearization 
 

Use the Linearization option to compensate for a non-linear response from the output 

device that will print the target. When device linearization is "off", the output device may 

print a different percentage of colorant than was called for by the software. This can 

result in patch values printing incorrectly, or different patch values printing the same 

color. Linearization corrects for this condition by optimizing the patch values for the 

specific device. Using linearization data is not recommended unless the printer or its 

associated RIP does not have its own linearization option. 

 

To use a linearization file in target creation, you must first create the linearization file by 

outputting and measuring a supported linearization target and saving the measured data. 

Once created, the linearization file is imported and referenced during target creation. 

 

You cannot use linearization with all target types. For a list of supported targets, see 

Supported patch sets by color space. 

 

To customize a target using linearization: 

 

1. Launch ColorPort and select the Create Target tab if it is not already active. 

 

2. Select a measurement device from the Measurement Device list. Configure any 

changes to the default device settings by clicking the Properties button. 

 

3. Select a color space for your target from the Color Space list. Linearization targets 

are only available for RGB, CMYK or PANTONE® Hexachrome color spaces.  
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4. Select a linearization patch set from the Patch Set list.  

 

Linearization patch sets are available in 5, 10, 20, and 40 step targets. Steps 

refer to incremental percentages of each colorant from 0% to 100% for 

CMYK and multi-channel devices, or 100% to 0% for RGB devices. 

 

5. Select the desired paper size and orientation, and configure the margins if 

necessary. 

 

6. Click the Save Target… button to rename and save the target to a directory of 

your choice. 

 

7. Print the newly created target in an application of your choice. For more 

information, see Printing a target. 

 

8. Select the Measure Target tab.  

 

9. Select the newly created linearization target from the Target drop-down list. 

 

10. Select and connect to your measurement device. 

 

11. Measure the linearization target. 

 

12. Click the Save Data… button. 

 

ColorPort recognizes that the measurement data is linearized. The Save dialog 

box will offer the option for ColorPort Linearization (.lin file format). If the 

data is for use with MonacoPROFILER, select this option. Otherwise, if you 

plan to use the data in another application, you may save it in Tab Delimited, 

CSV or CGATS formats. 

 

13. Return to the Create Target tab to create the target to which the linearization data 

will be applied. Select the desired instrument, color space and paper 

configuration. 

 

14. Select the desired patch set and click the Customize button. 

 

15. Check the Linearization checkbox. 

 

The caption next the Select… button will indicate "<No File Selected>". 

 

16. Click the Select… button. This will open a standard Open dialog box. Browse to 

the directory where the previously created linearization data was saved. Select the 

file and click Open. 

 

The caption next the Select… button will now show the name of the 
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linearization file. 

 

17. Configure any additional options in the Customize dialog box and click Save. 

 

The Target Preview pane will refresh and display the target with the applied 

linearization data. 

 

18. Configure the Paper Size options as desired. 

 

19. Click the Save Target… button to rename and save the target file to a directory of 

your choice. 

 

 

 

Customizing device options 
 

The Measurement Device drop-down menu displays spectrophotometers that you can 

use with ColorPort to measure a target. All new targets in the Create Target tab are 

automatically configured for the selected measurement device's settings.  

 

Use the Properties option to customize device-specific parameters. Changing these 

settings will modify the patch set you are creating. 

 

To customize device options: 

 

1. Launch ColorPort and select the Create Target tab if it is not already active. 

 

2. Select a measurement device from the Measurement Device list.  

 

3. Click the Properties button. NOTE: the Properties button will not be available if 

the Default Layout checkbox is selected. 

 

! The Properties window will display the default parameter settings for the 

selected device. 

! The default settings are based on the standard aperture size of the selected 

device. These settings may need to be adjusted to accommodate a different 

aperture size.  

! Device settings are displayed in mm, cm, or inches units of measure.  

 

4. Customize the settings by moving the appropriate sliders, or enter the new 

numerical values directly into the text fields. 

 

5. To preview the effects of device settings on a target, click OK. The Target 

Preview pane will refresh to reflect the new settings.  
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Note: If you are creating a reference file for an existing target, take patch measurements 

from the existing target and enter the values in the corresponding device Properties fields. 

 

 

 

Sharing targets with X-Rite applications 
 

ColorPort's saved target data is compatible with all X-Rite applications that use this type 

of information in their respective functions. ColorPort also offers powerful integration 

with MonacoPROFILER: compatible measured target data can be directly exported for 

use in MonacoPROFILER. 

 

To export measurement information to MonacoPROFILER: 

 

1. Create and measure a target created with a MonacoPROFILER compatible patch 

set. These patch sets, located in the Patch Set list in the Create Target tab, are 

denoted by "X-Rite" in their name. For more information see Supported Patch 

Sets by Color Space . 

 

2. Click the Save Data… button. ColorPort automatically recognizes the target data 

as being compatible with Profiler. Select as a file type "MonacoPROFILER 4.7 

and newer". 

 

! If ColorPort detects MonacoPROFILER on the same system, you will 

have the option to launch Profiler from the Save dialog box. 

! Note: if you are currently running MonacoPROFILER on the same 

system, you should return to the application and save the data in the 

current session. Otherwise, this data will be overwritten by ColorPort's 

exported session file. 

 

3. To Open a MonacoPROFILER session, check the Open Immediately checkbox 

and click Continue. The Save dialog box will open and allow you to rename the 

file and specify a location to save it to. 

 

The target data will be saved independently of the MonacoPROFILER 

Session File. 

 

4. You can now work with the exported data in an automatically configured session 

of MonacoPROFILER. 

 

! ColorPort automatically exports both linearization and profiling target 

data, if applicable. 

! Note: You will not be able to use the MonacoPROFILER Back/Previous 

button to re-measure patches while operating within a ColorPort generated 

session file. This is because ColorPort supports instruments, page sizes, 
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and patch configurations that MonacoPROFILER does not. 
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Appendices 
 

 

 

 

 

X-Rite, Inc. ColorPort 18   
 



Create Target tab interface 
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Measure Target tab interface 
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Printing a target 
 

You cannot print a target using the ColorPort application. Save the target as a TIFF or 

DCS2.0 file and print it using your standard workflow application. If you are outputting a 

multi-channel target, your output device must have a RIP capable of handling extra 

channels. 

 

During the printing process, it is important to make sure that scaling or unwanted color 

management of the target does not occur: the goal is to send unchanged target values to 

the printer. You can print the target using any application that you normally use to print 

images, as long as the color values are passed directly to the printer with neither the 

application nor the printer driver making any conversions.  

 

Before outputting a target, be sure your output device is working properly. If you are 

working with a device that has a linearization option, linearize the device before 

outputting the target. Load the appropriate media and output the target at 100%.  

 

 

 

Media / Resolution 
 

Materials such as colorants and substrates place limits on the gamut of reproducible 

color. For that reason, it is important that you use the same material throughout the 

measurement and reproduction process. For example, if you are creating and measuring a 

target for use in profile creation, use the same colorants and substrate or paper when you 

print the target as you will with the final product. 

 

ColorPort sets the appropriate target resolution. No adjustments are required. If you 

decide to change the target's resolution, be sure to maintain the same patch size 

parameters. If you alter the output size, you will affect the patch parameters stored in the 

reference file, and ColorPort may not be able to measure the target.  

 

 

 

Curing time 
 

Once the target set is printed, wait some amount of time until the ink is dry. This is 

especially important when printing to an inkjet printer. Even if the ink appears to be dry 

when it leaves the printer, the color is not stable. The only way to be sure is to take a few 

measurements, wait a while, and retake the measurements. When there is little or no 

difference in measurement results, the ink is dry and the target is ready for measurements.  

 

Once you know how long a particular paper and ink combination takes to dry, you can set 

the target aside for that amount of time in the future. 
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Target Size 
 

The target set may require trimming to be usable by certain measurement devices. The 

target file you created and saved in ColorPort includes all information that appeared 

inside the red bounding box in ColorPort's Target Preview pane. The user determines the 

final paper size when printing the target. If the target is printed on oversized stock, and 

the measurement device requires a smaller size (i.e., strip readers), the individual target 

pages will need to be trimmed to size. For more information, refer to your device's 

documentation for leader, trailer, and margins requirements.  

 

When trimming targets, refrain from cutting off the slug-line (printed line of target 

parameters on each target page) that is used to identify the target. 

 

 

Standard target information 
 

The following industry standard targets are included with ColorPort for standard and 

custom target creation: 

 

ECI2002 (Random and Visual) 

1485 color patches 

CMYK 

 

IT8.7/3 Basic 

182 color patches 

CMYK 

 

IT8.7/3 Extended 

968 color patches (60 white patches to fill page layout) 

CMYK 

 

IT8.7/4 (Random and Visual) 

1617 color patches 

CMYK 

 

FOGRA Media Wedge 

34 color patches 

2 graduated black and chromatic grey wedges 

Color patches are defined in percentage dot areas of the CMYK process colors  

 

Note: you must import the FOGRA Media Wedge target into ColorPort before you can 

use it. For more information about importing targets, see  Managing Targets .  

 

 

 

X-Rite, Inc. ColorPort 22   
 



Printing with Adobe Photoshop 
 

The following example uses Adobe Photoshop 7.0 as the printing application. 

 

You can configure Adobe Photoshop's Color Settings to control how it displays, 

interprets, communicates, and modifies the target. This example assumes the target is 

opened and printed without any changes to the default resolution. 

 

To print a target:  

 

1. Launch Adobe Photoshop.  

 

2. Configure the Color Settings dialog box.  

 

a. Select Color Settings from the Edit menu (Windows) or Photoshop menu 

(Macintosh).  

b. Under Color Management Policies, check the Missing Profiles: Ask When 

Opening checkbox. If this option is not enabled, select it from the 

predefined Settings drop-down list.  

 

Note: these settings are configured to pass the target without altering its 

values and may not be appropriate for processing images using your 

regular imaging workflow. 

 

 

3. Open the target TIFF or DCS 2.0 file:  

 

a. Select File > Open.  

b. Navigate to your saved TIFF or DCS 2.0 target file, select it and click 

Open. 

c. The Missing Profile dialog box will open. Select the Leave as is (don't 

color manage) radio button, and click OK.  

 

4. The opened target contains all information displayed inside the red bounding box 

in ColorPort's Target Preview pane. If you decide to change the resolution, be 

sure to adjust the image size so the patch size parameters do not change. 

 

5. Print the image file:  

 

a. Select File > Print with Preview...  

b. Check the Show More Options checkbox if it is not already selected.  

c. Select Color Management from the drop-down list below the checkbox.  

d. Select the Source Space > Document radio button. Since no profile is 

assigned, the source space is untagged. 

e. Select Same As Source from the Print Space > Profile drop-down list. This 

setting passes the color values unchanged to the printer driver. 
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f. Uncheck the Scaled Print Size > Scale to Fit Media checkbox. Be sure 

100% is entered in the Scale field.  

g. To select a different paper size, click Page Setup… and change the paper 

size selection. 

h. Click the Print… button; when the Print dialog box opens, click Print.  

 

 

 

Target data formats 
 

You can save target measurement data (even prior to completing all measurements) in 

one of two file formats: 

 

CGATS.17 

Text file - Tab Delimited or Comma Separated Values (CSV) 

 

To save target data, click the Save Data… button in the Measure Target tab, or select File 

> Save Data… 

The CGATS.17 file format includes patch measurements, all device and spectral values.  

 

The CSV and Tab Delimited option saves the following data in a combination of your 

choice to the selected file format: 

 

Colorimetric data 

§ Lab, LCH and XYZ 

§ Illuminant and Observer 

Spectral Reflectance data 

Densitometric data  

§ VCMY 

§ Minus paper 

§ Status: A, E and T 

 

Note: ColorPort will automatically detect if the data is a valid MonacoPROFILER target 

when saving. If ColorPort recognizes the target data as being a valid MonacoPROFILER 

target, the Save dialog box will have an additional option to export a MonacoPROFILER 

session file. For more information, see  Sharing Targets with X-Rite Applications . 

 

When exporting measurement data as a CGATS, tab-delimited, or csv file, you can 

choose the spectral range used by traditional X-Rite devices such as the PULSE (400-700 

nm), or the range used by traditional GretagMacBeth devices such as the Eye-One (380-

730 nm). 

 

NOTE: If you have measurements taken with a traditional X-Rite device and choose the 

larger range when exporting the measurements, the upper and lower measurement values 

will contain extrapolated, rather than measured, data. Similarly, saving measurement data 
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obtained with a traditional GretagMacBeth device to a file containing only 400-700nm 

will result in the loss of the upper and lower measurement values. 

 

 

 

CGATS information 
 

You can import CGATS information into ColorPort formatted in:  

 

CGATS.5 

CGATS.17 

 

You can save measured ColorPort target information formatted in: 

 

CGATS.17 
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Supported patch sets by color space 
 

 
 
* Linearization targets are only used with MonacoPROFILER compatible patch sets. 
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